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1.1 Introduction to XPS 

Refer to the Handbook of Spectroscopy* for a detailed review of XPS theory, XPS analysis using PHI instrumentation, and reference spectra for elements to assist with identification, quantification, and interpretation of XPS data.  

X-Ray Photoelectron Spectroscopy (XPS)  

also known as

Electron Spectroscopy for Chemical Analysis (ESCA)
[image: image1.jpg]XPS Process

@ Photoelectron

Etemmitever
2
X-ray (photon)

2s ) P P

i

1s Ty

Binding Energy

Binding Energy = X-ray Energy - Photoelectron Kinetic Energy




XPS is an essentially non-destructive technique which can be used to determine the composition of the outermost atomic layers of a solid material.  With the exception of hydrogen, all elements can be detected.  The average detect ability limit is approximately 0.05 atom percent.  The average depth of analysis is approximately 30Å.  Both elemental identification and chemical speciation are possible with careful analysis of the obtained binding energy information.  

XPS is accomplished by flooding the sample with x-rays of a known energy (typically Al Kα 1486.6ev).  Absorption of these x-rays by the sample causes photoelectrons to be emitted.  The kinetic energy of the emitted photoelectrons is measured with an electron spectrometer.  Binding energy is determined from the following equation:  BE = hν- KE where BE is the binding energy associated with the emitted photoelectron, hν is the energy of the x-rays being used and KE is the measured kinetic energy of the emitted photoelectron.  The binding energy associated with a peak is then used to establish its elemental identity and chemical state. 

The incoming x-rays penetrate microns into the surface of the sample.  However, the emitted photoelectrons, because of their low kinetic energy (less than 2000ev), can only travel a short distance without being scattered by colliding or interacting with other atoms and losing energy.  This short distance is referred to as the escape depth of the electron.  Escape depths range from 5 to 50Å, depending upon the kinetic energy of the photoelectron.  Photoelectrons that are close enough to the surface to escape without loss of energy will be detected as photoelectron peaks.  Those photoelectrons which lose energy before leaving the sample surface will add to the background of the spectrum.  This escape depth limitation makes XPS a surface analysis technique with an average depth of analysis of approximately 30Å.

Quantification is possible with the use of elemental sensitivity factors to compensate for the transmission function of the spectrometer and the change in photo-ionization cross-sections from element to element.  These sensitivity factors have been determined empirically and found to be in agreement with the current theoretical models for quantification of XPS data. 

Elemental and in some cases chemical depth profiling is possible with the use of an inert gas sputter ion gun.  The ion gun removes material exposing a new surface to be analyzed.  By sequentially sputtering and taking XPS data, a compositional depth profile may be generated.  If the chemical matrix of the sample is not damaged by the sputter ion beam, chemical information may also be obtained as a function of depth. 

In summary, XPS is a surface analysis technique that can provide:  elemental identification, chemical speciation, accurate quantification and depth distribution information.  

Instrumentation:  
Your samples were analyzed using our Physical Electronics XPS Spectrometer.  This is a fully computerized system which uses a spherical capacitor type analyzer (SCA) with an input lens that is capable of defining sub-millimeter analysis areas.  A multi-channel detector is used to enhance the sensitivity of the spectrometer.  

The data is displayed as a function of binding energy versus intensity in counts per second.   This intensity axis is labeled 0-10 and a scale factor is given at the top of each spectrum which is units of kilo-counts/second.  To determine the intensity of a peak you would multiply the height of the peak by the scale factor.  The binding energy of the peak is measured directly on the horizontal axis.  If the sample is insulating, an electrical charge may develop on the surface of the sample causing all of the peaks to shift to a higher binding energy.  To correct for this charging phenomena we reference all the peaks to a peak of known energy.  Typically carbon is used for a reference because hydrocarbons are present on most surfaces. This charge correction method allows us to obtain useful chemical state information from insulating samples.    
1.1.1 Types of XPS Data 

1.1.1.1 Survey 

A Survey is one spectrum acquired from a quick, high-sensitivity scan of a wide energy range (typically 0 to 1100 eV in 1 eV steps) to survey the elements present at a point on the sample or over an area.  In point analysis, a stationary x-ray beam is positioned on a specific point.  In area analysis, the beam is rapidly scanned, or rastered, over an area or multiple areas of the surface.  

1.1.1.2 Multiplex 

A Multiplex is a set of spectra acquired from a series of high-resolution surveys of narrow binding energy ranges (typically 4-31 eV wide in 0.25-1 eV steps).  This type of acquisition yields great sensitivity and spectral detail in a short analysis time, because only selected energy regions expected to contain XPS peaks of interest are scanned.  

The more commonly used multiplex acquisition routines are the line and profile. 

1.1.1.3 Depth Profiles

An XPS Depth Profile provides compositional data as a function of depth.  A sputter depth profile consists of a series of spectra that have been collected at different depths as material was removed from the sample.  An XPS depth profile is generally made by alternating sputtering with data acquisition.  The purpose of a depth profile is usually to verify or determine the construction of a thin film structure.  Other applications include studying inter-diffusion of layers, looking for impurities in layers or at interfaces, and general characterization of surfaces and thin films. Depth profile data can be used to extract chemical state information as well as atomic concentration data.  

1.1.1.4 Angle Profiles

An XPS Angle Profile provides compositional data as a function of depth.  Angle-Resolved (angle-dependent) profiles are used to probe the near surface region of a sample in a non-destructive manner.  Angle Profiles are possible, because the input lens of the analyzer (SCA) can operate with a small acceptance angle, and it is possible to tilt the sample in front of the analyzer.  The analysis depth at a given angle is defined by the equation: 

d =  sin 

where d is the effective analysis depth, 
is inelastic mean free path (escape depth) and 
 is the angle between the sample surface and the analyzer input lens.  

Angle Profiles are used typically to measure the thickness or explore the chemistry of very thin layers.  Applications include the study of chemically modified surfaces, lubrication, cleaning processes, and such.

1.1.1.5 Maps

A Map is a set of intensity-value arrays acquired over the area of the sample to show the surface distribution of specific elements.  Each array of intensity values corresponds to an element, and each value in the array corresponds to a point in the map area.  The intensity value is obtained by measuring the intensity at a specific XPS peak energy, then subtracting the background intensity.  

Acquiring map data for every element identified in the survey will completely characterize the distribution of elements in the analysis area.  These maps are then compared to the SXI image or platen view.

1.1.1.6 Line Scans

An XPS Line scan is acquisition of data along a single line across a sample. The intensity value is obtained by measuring the intensity at a specific XPS peak energy, then subtracting the background intensity.  

1.2 Manual Overview 

 The manual is divided into the following sections: 

Safety Notices and Warranty 

Section 1, Introduction and Overview
Overview of manual; X-Ray Photoelectron Spectroscopy; SmartSoft-XPS system software; reaching PHI Customer Service.
Section 2, Platen Manager
Creating platens; defining file management. 

Section 3, Prep
Acquiring sample and platen photos using the SPS station and the Intro camera. 

Section 4, Intro
Loading and removing platens; Vacuum tasks; Bake tasks. 

Section 5, Sample
SXI imaging; defining analysis positions; Navigation alignment; defining analysis areas.  

Section 6, XPS
Acquisition setup; acquiring data, analyzing and reporting XPS surveys, depth profiles, angle resolved profiles, lines and maps
Queue—Procedures for performing automated analysis. 

Section 7, Hardware: X-Ray; E-Neut, Ion Gun; C60(Option); Analyzer and Detector
Managing user settings; hardware calibration.
References to SmartSoft-XPS windows in this manual will use the following format to steer the user to a specific window or viewer.  

For instance to find the X-Ray gun Beam Parking parameters: 

Hardware > X-Ray > Properties > Service > Beam Parking

Select the Hardware Session; select the X-Ray Application tab; select the Properties button; select the Service tab: look in the Beam Parking section of this window.
1.3 System Hardware Overview 

The Quantera system console is split into two parts:  the left half of the system houses the vacuum chamber, while the right side contains all the electronic controls.  From the front of the console, the door for the sample introduction chamber and an electronics bay are visible.  The Quantera’s automated sample handling capabilities facilitate high throughput and unattended analysis.

Refer to the Quantera System Manual, PHI Part No. 647264, for information on the system hardware. 
Vacuum Chamber
[image: image2.png]lon Gun Hemispherical

Energy Analyzer

Monochromator

LaBsMonochromator

Electron Gun—\





All the X-ray and electron optics are located behind the panels on the left side of the system console, inside the vacuum chamber.  The Quantera uses a precision optics block enclosed inside the vacuum chamber to facilitate accurate alignment of the optics.  

A unique strength of the system is its ability to image and analyze features as small as 9µm in diameter.  The Quantera uses a small diameter electron beam to generate an X-ray beam of less than 9µm in diameter.  Scanning the electron beam on the X-Ray Anode provides secondary electron and ESCA imaging capabilities.

Electronics Front Bay

The electronics bay, or tower, is located to the right of the sample introduction door.  The electronics bay includes two Core Card Racks, hidden behind a removable panel above the exposed brown electronics control panels.  The Card Racks contain the boards that run most of the optics in the system.  
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Below the Card Racks are chassis-mount electronics controllers.

There are two Vacuum Gauge controllers that sense pressure in the introduction chamber and in the main chamber.   

The Digitel MPC ion pump controller is below the vacuum gauge controls. The ion pump control supplies high voltage to the ion pump elements and monitors ion pump current and voltage.  

The Electron Beam power supply runs the electron gun that is used to generate the X-ray beam. This unit is completely computer-controlled (no manual buttons or knobs).   

The Ion Gun control is at the bottom of the electronics bay. This unit is used for sputter depth profiling, sputter cleaning, and charge neutralization.  
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1. Main vacuum chamber

2. Electronics bay

3. Core card racks

4. Core card rack power on/off switch

5. Emergency Off  button

6. Turbo pump cooling duct

7. Turbo pump

8. Sample introduction chamber door

9. Video camera and lights.

Electronics End Bay

The end panel farthest from the sample introduction chamber door and adjacent to the electronics bay contains an Embedded-PC that controls all the hardware in the system. This computer acts as an interface between the PC Workstation and the electronics in the system. Below the embedded computer are a cooling fan and the heat exchanger, which holds water to cool the X-ray source anode.
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1. See boards installed in the Embedded PC 
2. Keithley™ Picoampmeter

3. Exp 16 board

4. Turbo pump controller

5. Circuit breaker control panel (accessible through separate CB door on backpanel, not endpanel)

6. Heat exchanger

7. Main transformer.
Boards Installed in the Embedded-PC
	Slot No.
	Function
	Part No.

	1
	Not used
	

	2
	CPU BD (486DX 66Mhz) 
	651608

	3
	Shield, BD GND 
	631877

	4
	Multiport controller PC/8
	647786

	5
	Network card 
	647358

	6
	Analog output BD DDA-06
	626566

	7
	Analog input BD DAS-1402
	626565

	8
	Cable routing slot for motion controller BD
	Slot 9

	9
	Motion controller BD, 4-Axis
	649833

	10
	24-bit parallel PIO-24 1/O Board 
	631800

	11
	Video VGA BD, ISA
	651849

	12
	Model 258 BD
	631873

	13
	Shield, BD GND
	631877

	14
	Not used
	

	15
	Flash electronics
	634763

	16
	MACH-8 electronics
	634584

	17
	MACH-8 electronics
	634584

	18
	Not used
	

	19
	Mach-8 electronics
	648286

	20
	Mach-8 electronics
	648286


Bay Top view
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1. TSP XFMR and phase control assemblies

2. 32-channel amplifier discriminator XE "Amplifier discriminator:32-channel" \i 
3. Model 80 sample and Anode bias supply 

4. Core Elex power supply XE "Power supply" \i 
5. Keithley™ Picoampmeter XE "Picoampmeter" \i 
6. Main power 200 – 240VAC, 60A, 5060Hz

7. Leak valve control PCB assembly XE "PCB assembly" \i 
8. Crystal heater XE "Crystal heater" \i 
9. SCA terminator assembly XE "SCA terminator assembly" \i 
10. System pneumatic control assembly XE "Pneumatic control assembly" \i 
11. Vacuum chamber hinge

12. Chamber open interlock switch.

Operator’s Table Equipment
The data system and its peripherals are placed on a table beside the system.  This equipment includes a PC workstation, a video monitor, and a color printer. 

The PC workstation is configured with a CD-ROM drive for backing up data on the hard disk and mass data storage. A seperate video monitor allows viewing of the Embedded-PC.

System Accessories (Optional)

The Sample Positioning Station (SPS) is an option used to locate small features on samples, which are not visible either on the Quantera’s platen photographs or in SXIs (X-ray-induced secondary electron images).  The SPS System uses a high magnification optical microscope to view samples.  SPS images can be viewed and grabbed within SmartSoft-XPS software and used for analysis position definition. 

Other accessories of the Quantera system include:

· Auxiliary Port Interface

· Additional Sample Carriers

· Hot/Cold Stage

· Cold Introduction Chamber.

System Power and Emergency Off

Typically, the Quantera system is on 24 hours a day and not powered on and off daily.  On the back of the system is a circuit breaker panel.  The individual circuit breakers within allow major segments of the console to be turned off for servicing purposes. 

In the event of a hazardous occurrence or emergency, the system can be shut off, using the Emergency Off buttons located on the front and back panels of the system console.  Pushing either Emergency Off button will disconnect all electrical power to the system.  Do not use the emergency buttons as an on and off switch, but only as a true emergency button. 

Power Interruption

In the event of a power interruption, the system console will recover automatically under the control of its Embedded-PC and begin to turn on pumps and valves necessary to maintain vacuum. It will be necessary to manually restart the SmartSoft-XPS software from the PC. 

Shutting down the Optics
Three optics devices in the system use hot filaments: the Electron Gun (X-Ray), the Ion Gun, and the Electron Neutralizer (flood gun).

To maintain thermal stability and minimize drift, the LaB6 filament used in the electron gun is left on continuously. The electron beam is either blanked or parked when not in use. 

The Ion Gun has a tungsten filament ionizer and it may be shut off daily.  If you expect to use the sputter ion gun, it is recommended that you put the Ion Gun in the Standby mode shortly before using it so that the ion gun is allowed to warm up (15 minutes).  

The Electron Neutralizer (flood gun) used for charge neutralization uses a barium oxide cathode.  It is recommended that the neutralizer be shut off at the end of the day.  The software controls the neutralizer with choices of OFF, Standby or ON. There is an Auto-Neutralization mode that turns the neutralizer ON at the start and Standby at the end of an acquisition.  

Daily Shutdown

At the end of the day, shut off the Electron Neutralizer and the Ion Gun unless you are performing unattended analysis.  The SmartSoft-XPS software will automatically set the Electron Neutralizer and the Ion Gun control to OFF if they have not been used within the operator-defined automatic turnoff time, typically one hour. The automatic turnoff time can be adjusted in the Properties Menus.

1.4 System Software Overview

The PHI Quantera is operated using three software packages:

 SmartSoft-XPS, for the primary operation of the system, including platen handling, stage navigation, SXI imaging, XPS analysis, depth profile sputtering; and charge neutralization
SmartSoft-XPS will also support C60 gun operation and C60 depth profiling for systems that include the C60 option.
 MultiPak,  for post-acquisition and off-line data reduction and reporting; and 

 Embedded-PC, the System interface onboard computer.  

The system computer uses the Windows( XP( operating system and comes with the Microsoft Office( suite.  Microsoft Office includes Word( for creating reports and articles, PowerPoint( for producing presentations, and Excel( for performing statistical analyses and generating graphs and charts.  Data from PHI software packages can be copied to the Microsoft Windows clipboard and pasted into any of the Microsoft software packages quickly and easily.  PHI data can also be saved in standard ASCII or graphics formats and inserted into the Microsoft software packages.  

1.4.1 Introduction to SmartSoft-XPS
SmartSoft-XPS is a Windows-based interface with five primary “Sessions” devoted to different tasks:

 PREP, for capturing SPS station and Intro photos of the sample/platen;

 INTRO, for loading and unloading samples or platens;
This section also includes system control including vacuum and bake functionality;
 Sample, for locating and selecting analysis positions and SXI imaging;

 XPS, for acquiring XPS surveys, depth profiles, angle resolved profiles, line scans, and maps;

 Hardware, for Xray-Gun setup, analyzer and detector optimization, depth profile and general sample sputtering and charge neutralization.

1.4.1.1 SmartSoft-XPS Operator Interface   
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SmartSoft-XPS user interface consists of major interactive areas; the Session tabs [each consisting of an Output area and Input area], the Menu bar and the Status bar.  Flow across the user interface is from left-right across the Sessions and top-bottom down the Application tabs. Each Session will reveal corresponding viewers in the Output area and unique Application tabs in the Input area.
Session Tabs

There is a dedicated section of the manual for each Session with detailed description of each Session’s Output and Input areas.  Each section will contain user tasks related to this Session.  Sessions can be accessed across the top of the SmartSoft-XPS window or through the Menu bar.

Output Areas

The Output area consists of the viewers listed below with the corresponding Sessions that use these viewers [refer to the corresponding “Session” section of the manual for detailed information regarding each viewer]:

Photo Viewer
Prep

Chamber Viewer
Intro

Vacuum Viewer
Intro

Platen Viewer
Sample

SXI Live Viewer
Sample
Saved Image Viewer 
Sample
Position List Table 
Sample
Spectral Viewer 
XPS
Profile Viewer [Line] 
XPS

Image Viewer [Map] 
XPS
Tile/Fullscreen:
Each viewer in the Output area typically can be toggled between a tiled viewer and a fullscreen viewer.  Use the Tile/Fullscreen icon in the upper left corner of each viewer for this operation. 

Toolbar:
Each viewer contains a Toolbar area across the top that either will launch a unique task or define modes for other interactive operations.  These Toolbars are discussed in each “Session” section of the manual.
Tooltip: 
Holding the cursor over icons within each viewer will display a Tooltip revealing either names of icons or information related to that icon.

Context: 
Right-clicking within a viewer will reveal Context menus giving access to other operations or Properties windows.
Input Areas [Application Tabs]

Each Session contains its own unique set of Application tabs providing control parameters related to the tasks.  The Platen Manager Application tab is involved with most Sessions and will be located at the top of each Input area.  The Platen Manager is discussed in detail in its own section of the manual.  The remaining Application tabs are described in detail in the corresponding “Session” sections of the manual.  

Each Application Tab will provide access to commonly used parameters.  Other less frequently used parameters or parameters that define default modes of operation can be found in the Advanced Properties window.  A button is available at the bottom of each Application tab to open these windows.
Editing Values in Entry Fields: 
Clicking on a field will “insert the cursor” and double-clicking on a field will “select the value in the field” allowing the user to perform one of the following editing techniques.

Note: hardware will change when Return is selected with the following
· Insert numbers to the current value and hit Return
· Replace the value and hit Return
Note: hardware will change instantly with the following
· Slew/step the value with the mouse wheel

· Slew/step the value with the keyboard up/down arrows

· SPECIAL case paired fields such as X,Y can be slewed/stepped using the left-right keyboard arrows for the 1st pair and using the up/down keyboard arrows for the 2nd pair.

Toolbar: 
Some Application contains a Toolbar area across the top that either will launch a unique task or define modes for other interactive operations.  These Toolbars are discussed in each “Session” section of the manual.

Tooltip: 
Holding the cursor over icons or entry field names will display a Tooltip revealing either names or related information. Holding the cursor over entry fields will display a Tooltip revealing parameter ranges for that field.

Context: 
Right-clicking within an Application Tab will reveal Context menus giving access to Diagnostics windows and Application Log windows.  
The Diagnostics windows provide a further level of control and/or hardware read-backs typically for use by service engineers. 
The Application Log windows provide a history of events that are related to each Application.  A file will be saved during the current session of SmartSoft-XPS and three backup copies saved during the last three sessions of running SmartSoft-XPS.  All high-level-tasks listed in the Application Logs will be separated by a dashed line.  The combo box at the bottom of the window will allow selection of other Logs.
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The File and Edit menus provide typical MS editing capabilities related to the text in the log.  The combo box on the bottom will provide access to other Application Logs.  The window can be minimized or closed.  
Platen:
This tab will record all platen transfer events

Vacuum

This tab will record all vacuum events including subtask operations and conditional operations

Bake

This tab will record bake tasks 

Bake Report

This tab will record thermocouple and other hardware readings during a bake

Stage

This tab will record all stage, arm, anode and monochromator motor events

Acquisition

This tab will record all pre-acquisition, acquisition and post-acquisition events

Ion Gun

C60 Ion Gun

X-Ray 

E-Neut
These tabs will record error logging events

Status Bar
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The Status Bar is located below the Input/Output area.  A yellow box will appear around the Stage area when the stage is in motion.  A yellow box will appear around the Platen area when the “Current” platen is not at the Stage station. A red box will appear around the Gun areas when a communication error has occurred with that device.  The Status Bar provides real-time display of the following fields.

· Last acquisition, vacuum, platen or stage control status

· Current X,Y,Z,R,T positions

· Current platen station location and platen name

· Xray-Electron gun state (Park, On, Off)

· E-Neut state (Neutralize, Standby, Off) (Auto Neutralization state)
· Ion Gun state (Neutralize, Sputter, Blank, Standby, Off)  (Auto Neutralization state)
· C60 Ion Gun state (Sputter, Standby, Off)  
Context: 
Right-clicking within the “gun” zones of the Status Bar will reveal Context menus giving access to re-initialization operations, states of each gun and Auto Neutralization states.
Menu Bar 

The menus in the menu bar include:

File: 
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Open..:

This provides an Open dialog box allowing the user to open a datafile.
Save Position List and Save Position List As..:

The Position List Table is automatically saved when the “current” platen is changed or when SmartSoft-XPS is exited.  These provide an option to save this list at any time.
Save Workspace:

The Platen Manager is automatically saved when the “current” platen is changed or when SmartSoft-XPS is exited.  These provide an option to save this at any time.
Print Setup..:

This provides an Print dialog box allowing the user to define the default printer for all SmartSoft-XPS print operations.
Exit:

Selecting this will safely shut-down the hardware and exit SmartSoft-XPS.

Sessions: 

This reveals an extended pull-down list providing access to any Output Viewer; Application Tab; and Properties Windows within each Session.

Views: 

This reveals an extended pull-down list providing access to Output Viewers and Viewer Properties; customized as a function of which Session is currently open.
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The top three selections can be used to change the SmartSoft-XPS window between Normal (Output Area and Input Area); Input Tabs (Application Tabs only; related to the current Session) and Output Tabs (current Output Area viewers only; related to the current Session)

Data: 

This reveals an extended pull-down list providing the ability to close data files within the three data viewers.
Additional selections include:
Data > Spectrum > Smooth…:
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Smooth Properties provides options related to the Smooth tool in the XPS > Spectral Viewer.  Changes will be reflected in the Smooth icon label in the XPS > Spectral Viewer and in future smooth operations performed.
Data > Image > Properties:
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Opening this Image Properties while an image is loaded in the XPS > Image Viewer will provide information related to that data file.

Tools: 
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System Configuration...:

This opens the System Configuration window providing the ability to select hardware options for SmartSoft-XPS control.  Editing this will require restarting SmartSoft-XPS for the changes to take affect.
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System Parameters...:

Selecting this will open WordPad containing a complete listing of system parameters.  Standard WordPad editing and saving is available.

Z-Align Log...:

Selecting this will open a log of results from the last Z-Align acquisition.  Standard editing options are available

System Log Setup...:
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Selecting this will open a SmartSoft-XPS window providing tools to setup which devices are being logging in the System Log.log file.  This is typically set to Trace=Off and can be used by service personal to troubleshoot software/hardware control issues.
Note: Right-clicking within the Trace combo boxes provides a “Set All” option to expedite setting all Doc, View or Object Traces to one selection.
Selecting the System Log… button will open the System Log file.

Open System Log.. Ctrl+L:
Selecting this will open the System Log.log file using the LogViewer application.  This can be used by service personal to troubleshoot software/hardware control issues.

Queue: 

Clear Queue:

This will clear all Queue Jobs from the Queue
Queue:

This will open the Queue window
User Level: 

Change User Level:

This will open the SmartSoft-XPS Login window
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User Levels are defined as User, Superuser and Service.  The User user level provides access to parameters required to perform normal sample handling and data acquisition task.  The Superuser provides access to other tuning parameters.   The Service user level has complete access to all parameters and tools within SmartSoft-XPS and this level is password protected.  
Select the desired User Level and click OK.
Help
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SmartSoft Help:
Selecting this will provide access to the .htm User Manual.  The home page for this manual provides icon links to the Introduction and Overview section; five Session sections; the Platen Manager section and three support documents.
About SmartSoft-XPS…:
Selecting this will open the About SmartSoft-XPS window.
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1.4.1.2 Operation Overview
Typical operation is performed within the Prep, Intro, Sample and XPS Sessions and does not require the user to startup or setup hardware.  Most of this is automated; leaving the user with the following tasks: 

· Sample introduction, platen manager setup and capturing photos performed in the INTRO Session and Prep Session
· Analysis area definition, SXI imaging and Z-Alignment performed in the SAMPLE Session
· Acquisition setup, data acquisitions, data review and Queue operations performed in the XPS Session
Navigating on the Platen is accomplished using the Platen Viewer and SXI Viewer on the Sample Session.  See this section of the manual for detailed description of the following: 
· Coarse XY moves are accomplished dragging the Stage Marker within the Platen Viewer.  
· Fine XY moves are accomplished with the Point-n-Click feature in the SXI Viewer. 
· Z-Height adjustment is accomplished with the Z-Align tool in the SXI Viewer and with the pre-acquisition Z-Align option in the Acquisition Properties.

· Compucentric Rotation is accomplished with the Rotate Horizontal tool in the SXI Viewer.

· The “Stage” Application is only needed for manual Tilt changes. 
Vacuum tasks such as Pump/Vent Intro, Pump/Vent Chamber, Sublimation pumping, Baking are performed in the Intro > Valves, Sublimation or Bake tabs: 

Gun performance tuning or creating new gun settings are performed in the Hardware tabs: 

Analyzer/Detector performance tuning is performed in the Hardware tabs: 

Automated setup is found in the following locations: 

	Automated Intro Photo
	Prep > IntroCamera > IntroPhotoTakeDuringPlatenTransfer
Intro > OutPutArea > ChamberViewer > IntroContextMenu

	Automated Sputter setup
	XPS > Profile > SputterTable
XPS > “Application” > AcquisitionProperties > Setup > Pre-Sputter

	Automated X-Ray 
setup during 
SXI & SXI Z-Align
	Sample > SXI > SXIProperties > Setup
Sample > OutputArea > SXIViewer > ContextMenu > Setup

	Automated X-Ray 
setup during Acquisition
	XPS > AcquisitionApplicationTabs

	Automated E-Neut Neutralization setup
	XPS > “Application” > AcquisitionProperties > Setup
Sample > SXI > SXIProperties > Setup
Sample > SXIViewer > Toolbar > Context > Properties > Setup
Intro > OutputArea > ChamberViewer > E-Neut 
StatusBar > E-Neut > ContextMenu

	Automated Ion Gun Neutralization setup
	XPS > “Application” > AcquisitionProperties > Setup
Sample > SXI > SXIProperties > Setup
Sample > SXIViewer > Toolbar > Context > Properties > Setup Intro > OutputArea > ChamberViewer > IonGun
StatusBar > IonGun > ContextMenu

	Automated Analyzer settings 
[SXI ,Z-Align 
& Detector]
	Hardware > Analyzer > AnalyzerSetting

	Automated Ion Gun Differential Pumping & Argon Gas Admission
	Hardware > IonGun > Properties > Service

	Automated X-Ray 
Beam Parking
	XPS > “Application” > AcquisitionProperties > Setup
Hardware > X-Ray > Properties > Service


1.4.1.3 Settings
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Many of the Application tabs include a “settings” area.  A setting is a group of parameter values related to the displayed application tab.  The settings area allows the operator to save and retrieve parameters as settings for future use.

NOTE:  Not all related parameters are stored when a setting is created.  Some parameters will have the same value regardless of the setting, but can be changed individually by the operator.    

Special Settings:
The PREVIOUS setting is found in all the setting areas, and will load the setting that was active prior to the last system shutdown.  The PREVIOUS setting is updated whenever the operator moves to a new session tab or exits SmartSoft-XPS.  
The INITIAL setting is found in settings areas that save hardware parameters.  The INITIAL setting is automatically selected when the system is first started as it sets the system hardware to safe default parameters. 

Load Settings:
To select a setting, use the text box to highlight the desired setting, then click Load.  
Note: Selecting and loading a setting with the E-Neut, Ion Gun or C60 Ion Gun in an OFF state; allows the user to view parameters without voltages being applied to that gun.
Alternatively, you can restore a setting that was used during the acquisition of a specific data file.  Data files (Surveys, SXI images, Maps, etc.) generated in SmartSoft-XPS include information on the settings used during their acquisition.  Click the File button in the settings area and then select the desired data file.  The file itself will not open, but the settings stored with it will be loaded into the active Application Tab. 

Save Settings:
To create a new setting, set the parameters as desired.  Type a setting name in the text box and click Save.  
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Delete Settings:
To delete a setting, select it and then click Delete.
Note: some settings are RESERVED and cannot be deleted.
1.4.2 Introduction to MultiPak

MultiPak has four main windows:  the Spectrum, Profile, and Map windows, which are very similar in appearance and layout, and the Periodic Table window.  

At startup, the Spectrum window is displayed on the left side of the desktop and the Periodic Table window is displayed on the right.  When opened, the Profile and Map windows are displayed on the right side of the desktop screen.  The Profile and Map windows will be displayed on top of the Periodic Table window.  (Another MultiPak window can be moved to the foreground by selecting its name from the Window menu of any MultiPak window.) 

The extension of the file name determines which window a data file will open in, as follows:

· Spectrum Window—files having the SPE (spectral data) extension.  SPE files contain survey and multiplex acquisitions.  Surveys are scans performed over certain binding energy ranges to identify the primary elements present in a sample.  Multiplexes are scans that contain multiple regions, each of which typically contains a single element.  

· Profile Window—files having the PRO (depth profiles), ANG (angle resolved profiles) or LIN (line scans) extensions (plus associated spectra in the Spectrum window).  Depth profiles are performed to obtain compositional data as a function of sample depth.  Angle profiles are performed to measure the thickness or explore the chemistry of very thin layers.  Line profiles provide the surface distribution of an element along a straight line.  A line profile is collected point by point over the defined line. 

· Map Window—files having the MAP (map images) and SXI (scanning x-ray images), plus associated displays in the Spectrum window.  MAP files provide information on the two-dimensional surface distribution of an element.  Map data is collected point by point in a grid fashion over a selected area of the sample.  SXI  files are XPS image acquisitions.  

Each window has a menu bar, upper and lower toolbar, region bar, a header area, and a status bar, as described in the following subsections.  

1.4.2.1 Parts of the MultiPak Window.
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1.4.2.2 Menus, Selecting Functions, and Other Windows Terminology

MultiPak’s three main windows (Spectrum, Profile, and Map) use the same seven “main menus” on their menu bars:  File, Edit, View, Tools, Data, Window, and Help.  A MultiPak function is started (“selected”) by finding it on a menu or an associated cascading “submenu,” then highlighting it and releasing the mouse button.  Many functions can also be started using short-cut keys (shown on the menus) or clicking on (“pressing”) a pushbutton in the upper toolbar.  

Selecting a Function from a Cascading Menu:  
“Select Tools–Atomic Concentration Table–Print.”     

[image: image23.wmf]
Parameters for a function are set by the operator using a dialog box or the lower toolbar.  Common features of these—“option menus,” buttons, and boxes—are illustrated below.  Other menu items are followed by an ellipse (…), such as Print (“Print(”) on the File menu, meaning that a dialog box will open when the menu item is selected.  

1.4.2.3 Toolbars and Region Bar

MultiPak has three toolbars:  the upper toolbar, the lower toolbar, and the region bar.  A toolbar is a portion of a window that contains “buttons” that can be used to perform many functions in MultiPak.    

The upper toolbar is located below the window’s menu bar and above the data display area of the window.  The lower toolbar is located below the data display area and above the region bar.  The region bar is located below the lower toolbar and above the status bar.  

1.4.2.4 Buttons, Check Boxes, and Option/Drop-Down Menus.  
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1.4.2.5 Header

The header, displayed above the data’s axes, is the listing of parameters from the currently selected data file.

1.4.2.6 Status Bar

The status bar, located at the bottom of the window, is used to display operator messages, system notices, and the name of the currently selected file.

1.4.2.7 Current or Selected Data

When multiple sets of data are displayed in a window, a green title above a set of data indicates that it is the currently selected data.  The file name of the selected data set is also displayed in the status bar at the bottom of the window.  Data are selected using the left mouse button.  

Most functions, when activated, are applied to the current spectrum or image only.  Further, many functions will retain their last setting indefinitely, so that displays of newly opened spectra or images will be based on that setting.  

The terms “current,” “selected,” and “currently selected” are all used.  

1.4.2.8 Formats for Viewing Multiple Axes 

Four formats are available for viewing multiple axes in a single window at the same time.  Up to 36 axes (six rows and six columns) can be displayed concurrently in three of the views:  Landscape (oriented in rows first, then columns); Portrait (oriented in columns first, then rows); and Square (landscape arrangement but all axes are equal in size).  Up to 6 axes can be displayed concurrently in the Stack view (stacked in six rows in one column).  

1.4.2.9 Analysis Data Set 

This subsection briefly describes the types of files that can comprise an XPS data set and other general information about a data set that the MultiPak user should be aware of.  

XPS data can include some or all of the following types of files:  

· Spectra, stored in files having the extension “SPE,” which will open in MultiPak in the Spectrum window.  Each file contains a series of data points from one point (stationary x-ray beam was positioned on a specific point) or area (rapidly scanned or rastered over an area of the surface).  Spectra are acquired either as surveys or multiplexes.  A Survey is a quick scan over a wide contiguous binding energy range to survey the elements present in a sample.  A Multiplex is a high-resolution scan of several narrow energy ranges to obtain enhanced sensitivity and spectral detail.  

· Maps, stored in files having the extension “MAP,” which will open in MultiPak in the Map window.  Maps provide information on the two-dimensional surface distribution of an element across the analysis area.

· Line scans, stored in files having the extension “LIN,” which will open in MultiPak in the Profile window.  Line scans provide information on the surface distribution of an element along a straight line through the analysis area.  

· Depth profiles, stored in files having the extension “PRO,” which will open in MultiPak in the Profile window.  Depth Profiles provide information about the distribution of an element as a function of depth (after the surface has been sputtered).  

· Angle profiles, stored in files having the extension “ANG,” which will open in MultiPak in the Profile window.  Angle Profiles provide information about the thickness or chemistry of very thin layers.  

· Images, which will open in MultiPak in the Map window.  XPS imaging capabilities generate “SXI” (scanning x-ray image) file types.  An image is used during acquisition to define the analysis area where additional data is to be acquired.  The analysis area may be the whole image area or a subset of it.  

1.4.2.10 Other Important Data File Characteristics 

Each data file in a set has characteristics important to the analyst using MultiPak, such as which files contain data from the same analysis area or point and whether the same hardware parameters (e.g., beam voltage, beam size, etc.) were used to acquire the data.  Some of this information can be found in the file’s “header,” which MultiPak will display along with the acquired data, but some of it will have to be known by the analyst to ensure that appropriate analyses of the data files are performed.  

1.4.3 Introduction to Embedded software 

PHI Embedded-PC is a system interface onboard software application.  The software operates on an internal onboard computer and requires no user interface.  The key-board and monitor remain connected typically for Service Personal functionality.  The system is available only to PHI Customer Service or a site technician who has been trained on the system.  

Note:    It is necessary to keep the Embedded-PC application running as SmartSoft-XPS makes calls to the Embedded-PC application to perform system tasks.
1.5  How to Reach PHI Customer Service

Contact PHI Customer Service for any equipment repair, routine maintenance, service contract or problem solving needs.
ULVAC-PHI, Inc.

Address: 
370 Enzo, Chigasaki,


Kanagawa, 253-8522, Japan

Phone: 
81-0467-856522

Fax: 
81-0467-854411

Email: 
servicejp@phi.com
Physical Electronics

Address: 
18725 Lake Dr. East


Chanhassen, MN 55317

Phone: 
952-828-6200

Toll Free: 
800-922-4744

Fax: 
952-828-6325

Email: 
service@phi.com
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